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HOMEBASE 2.1 

Welcome to HomeBase 2 from Abebooks 

HomeBase 2 was developed by the Advanced Book Exchange. It is a software program for 
managing your bookselling business by helping you keep track of books, catalogs, clients, wants, 
and invoices. Using HomeBase 2, you can maintain accurate records, print your records, and 
share information with booksellers around the globe. 

When we designed HomeBase 2 we paid special attention to the data entry screens to make 
them as simple and easy to use as possible. We have also added many features that really 
streamline the data entry process. 

To customize HomeBase 2 for your bookstore, go to the Getting Started: Using the Setup Wizard. 

Abebooks 

The Advanced Book Exchange (Abebooks): The Internet's largest and most popular source for 
used, rare, out of print, & antiquarian books. Through the power of the Internet, anyone who has 
access to the World Wide Web can search and order books from our thousands of member 
bookstores around the globe. 

Sell Your Books on the Web with Abebooks 

Putting your books on Abebooks increases their exposure enormously. Instead of being restricted 
to a relatively local market your books will be available on a global scale. Also, if you are located 
in the United States you may join the Barnes and Noble program and sell books through their 
site.  

People looking for books can use the powerful search engine or the catalog-browsing feature, 
which divides the catalogs into subjects and topics. Becoming a member of Abebooks’ friendly 
team will increase your exposure to the world, resulting in more sales.  

Abebooks Membership Advantages:  

• A reasonable monthly rate. 
• Access to our wants page, where you can see a list of over a million books people are 

searching for. 
• A free Homepage on the Internet where you can direct your customers to browse and 

search your personal bookstore inventory 

Nightly Want Matching 

Anyone who is searching for a book can save his or her search request as a want. Then, when 
new books matching the search request are added to Abebooks' inventory, Abebooks sends an 
e-mail message to the buyers. The email gives the buyer specific contact information so that the 
buyer can contact the seller. 

Let’s say for example that you are looking for a hard cover copy of Richard Bachman’s The Dark 
Tower. You would save your want and we at Abebooks will compare all incoming books with your 
want. When we find a match, we’ll send you an email note letting you know which bookseller 
have the book for sale. 

Send Your Books and Wants to Abebooks 

Abebooks accepts book and want records in many formats. If you are not using a recognized 
book inventory program, we can convert your data so that it can be displayed on Abebooks. Then 
if you wish, you can load it into HomeBase2 or another recognized book inventory program. 
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HomeBase 2 is a fast and easy way to send book records and wants to Abebooks. With a few 
simple steps your book records can be viewed and ordered through the Internet. 

HELP MODULE 
Quick Tour 

When HomeBase 2 starts up you are presented with the List Books screen: 

 
 
The book spine on the left shows you what you are currently viewing and provides a means to 
select the various List screens by clicking on the text in the spine. 

The Find Books area allows you to enter information that will narrow down the book list to those 
books that match the entered criteria. There is an equivalent Find area for each list screen 

Toolbar 

 
 
The toolbar provides easy access to the most common functions. The function of each button is 
(from left to right): 

 
Add new Book Opens the Add Book Screen from any list screen 

 
Add new Catalog Opens the Add Catalog screen from any list screen 
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Add new Want  Opens the Add Want screen from any list screen 

 
Add new Client Opens the Add Client screen from any list screen 

 
Add new Invoice Opens the Add Invoice screen from any list screen 

 
Add new record Opens the Add screen for the current list 

 
Edit current record Opens the Edit screen for the current list 

 
Delete current record Deletes the current record(s) 

 
Reports  Opens the Report screen 

 
Options Opens the Options screen 

 
Send to Abebooks Opens the Send to ABE screen 

 
Browse ABE Opens the Abebooks homepage in the default browser 

 
Opens this help document 

  
Navigating in HomeBase 2 

When in the edit or add screens of HomeBase 2, use the Tab key or your mouse to move from 
one field to the next. The Enter key activates the default button, which is usually Save. 
 
Getting Started 

Loading HomeBase 1 Data 

Warning: If you use this facility, any data that you have in HomeBase 2 will be deleted.  You 
must have previously created a backup from HomeBase 1 to use this command. 

1. Select Load HomeBase v1 data from the Tools menu. The Import Version 1.x Data 
screen is displayed. 

2. A message asks if you wish to continue. Click Yes. The Select HomeBase Version 1.x 
Backup File screen is displayed. 

3. HomeBase displays your HomeBase 1 backup folder. Select the file you wish to open 
and click Open. 

4. The Load HomeBase Files progress screen is displayed.  
5. When the loading has completed, an error report is generated. If there were any errors it 

is advisable to save or print the report. Click Close. The Auto-Generate Book Numbers 
screen is displayed.  

6. If you would like HomeBase 2 to automatically generate book numbers, click Yes. 
Otherwise, click No. 

  
Getting Started: Using the Setup Wizard 

The Setup Wizard automatically starts when you run HomeBase 2 for the first time. It is a step-by-
step program that is designed to make the start up process easier for you. The Setup Wizard 
helps you to enter your bookstore information and if desired load your HomeBase 1 data into 
HomeBase 2.  
 

1. The Welcome to HomeBase 2 screen is displayed. Click Next.  
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2. Type your store information, including the name, address, city, prov/state, country and 
zip/postal code. Click Next. 

3. Type your Contact information, including your phone number, email address and your 
name. When you type your phone number please remember to include the area code. 
Click Next. 

Note:  

• If you are going to send your HomeBase 2 files using FTP you do not need to fill in 
the SMTP server name. You only need to do this if you are sending files through 
email. 

4. Type the names and rates for all applicable sales taxes. Click Next. For more information 
on entering tax rates, see Entering Tax Names and Rates below. 

5. If you are a member of Abebooks (vendor), type your Abebooks UserID and your 
Abebooks password. Click Next. If you are not a member and would like more 
information or would like to become an Abebooks member, How to Reach us at 
Abebooks on page 13. 

6. If you: 
• Want to load data from HomeBase 1 into HomeBase 2 click Load. The Import 

Version 1.x Data screen is displayed. Please note that if you use this facility, any 
data that you have in HomeBase 2 will be deleted.  

1. Click Yes. The Select HomeBase Version 1.x Backup File screen is 
displayed. 

2. HomeBase 2 automatically opens your HomeBase 1 backup folder. 
Select the file you wish to open and click Open. 

3. The Load HomeBase Files progress screen is displayed.  
4. When the loading has completed, an error report is generated. If there 

were any errors it is advisable to save or print the report. Click Close. 
The Auto-Generate Book Numbers screen is displayed.  

5. If you would like HomeBase 2 to automatically generate book numbers, 
click Yes. Otherwise, click No. The Confirm Auto-Numbering maybe 
screen displayed. Click Yes to confirm. 

• Do not have data to load from HomeBase 1 at this time, or do not want to load 
data from HomeBase 1, click Finish. 

Note:   

• If at any time you want to load data or change your bookstore information you can run 
the Setup Wizard by clicking Tools on the menu bar and clicking Setup Wizard. 

 
Entering Tax Names and Rates 

HomeBase 2 allows you to define up to three separate tax rates for use in the invoicing function. 
Each time you create an invoice, you will be able to select from the defined taxes, and apply one 
or more of these taxes to the invoice. HomeBase 2 automatically calculates selected taxes into 
the total of your invoice, and displays the tax names and rates on the printed invoice. 

HomeBase 2 Features 

Adding A Book Using ISBN Lookup 
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This service is only available to www.abebooks.com member booksellers. It is requirement to be 
connected to the Internet for this function to work! 

Disclaimer: 
 
All information retrieved through the ISBN Lookup should be verified for accuracy. Occasionally, 
discrepancies do occur between the information retrieved and the information contained within the 
book (e.g. change in publisher name after the date of publication). It is the bookseller's responsibility 
to ensure that all information is correct.  Abebooks does not guarantee the accuracy of the 
information as third parties provide it. 

Abebooks uses Bowker.com to supply the ISBN data used in our lookup feature. 

The ISBN Lookup enhancement enables registered abebooks.com booksellers to catalogue their 
books much more conveniently and quickly. 

When an ISBN Lookup number is entered, HomeBase 2 automatically retrieves some of the 
book's associated information (e.g. author, illustrator, publisher, etc.) and displays it in the 
appropriate field boxes. Other information required to list the book, such as condition and edition, 
is entered manually. 

1. Click Books on the Abebooks spine. The Find Books screen is displayed.  

2. Click the Add icon . 
3. Type the ISBN number into the ISBN Lookup field. 
4. Click the ‘ISBN Lookup’ button to retrieve book Information from abebooks.com. 

Note:  

• Any field that you filled in previously will not be updated when the ISBN Lookup is 
used. 

5. Fill in the rest of the information about your book. You can move from field to field by 
using the ‘Tab’ key. 

6. Click the ‘Save’ button to save the information and return to the Find Books screen or 
click the ‘Save/New’ button to save the book and add another book. 

Setting ISBN Preferences 

ISBN Preferences can be set to determine which information you wish to receive. 

1. Click the ‘ISBN Preferences’ button. This will connect you to abebooks.com. 

2. Choose your ISBN Preferences. 

Book # 

HomeBase 2 assigns each new entry a Book #, which appears in the first field on the left, labelled 
("Book #"). You may choose to assign your own Book #s, as long as each Book # is unique. To 
do this, go to the Options screen. 

Intelligent Fields 

• Most fields on this screen are Intelligent Fields, which recognize, and fill in, previously 
entered information. 

• An Intelligent Field is identified by the arrow and the pencil to the right of the field. 
• As you type the first characters of your entry, HomeBase 2 searches in the drop-down list 

for matching entries. The first alphabetically matched entry appears in the field as 
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highlighted text. If the matched entry is the one that you want, TAB to the next field. The 
matched item remains in the field. 

• If the matched entry is not the one you want, continue typing your entry. HomeBase 2 will 
add the new item to the drop-down list for future use. Some fields will prompt you to 
confirm the addition of the new item and to provide additional information for Abebooks 
searches. 

 
Keywords 

HomeBase 2 uses words entered in the Keywords field to locate books from the Find function. If 
ISBN keywords are available ISBN Lookup will enter keywords, which describe the content or 
category of a book, so that books may be easily located during future searches. You may add or 
delete these keywords. 

Note:  

• The keyword field in HomeBase 2 allows you to enter an almost unlimited amount of 
characters, but only the first 2,000 characters will be saved with your online inventory 
on abebooks.com. 

Entering Book Cost/Price 

• Whole currency amounts only require a single number. HomeBase 2 automatically 
converts the entered number to a currency amount when you leave the field. 

• To enter a partial currency amount, you are required to enter the decimal point after the 
whole currency amount. (For example, to enter $8.25, type 8.25. HomeBase 2 will 
convert a whole number to a whole currency amount.) 

• You do not need to enter a currency sign such as the $. 
• When you move from the field, HomeBase 2 automatically formats the entered number 

as a currency amount. 
• Amounts entered into the "My Cost" field will appear only on your own copy of HomeBase 

2. They will not be displayed on Abebooks, and will not be accessible to other Abebooks 
users.  

 
Sticky Fields 

Sticky fields are fields that retain entered information each time you refresh an Add screen by 
clicking the Save/New button. 

Information entered into a sticky field remains the same each time a new Add is started, so you 
don’t have to re-enter the same information. Any information you enter into a sticky field (for 
instance, Publisher Name) will remain in that field after you complete an Add and select 
Save/New. 

If you type over the information in a sticky field, your new entry replaces the highlighted text. The 
new information will reappear in the field when you select Save/New. 

You can sell all fields to be sticky or you can specify which fields are to be sticky and which are 
not. For example if you are entering a series of books with the same author and publisher you 
could set the author and title fields to be sticky. 

You can set sticky fields in the Add Books, Add Clients, and Add Wants Screens. 

To select sticky fields in an add screen: 
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1. Go to the Add Screen 

2. Click on the black text beside the field 

The text beside the field changes from black to color, indicating that the field is now Sticky. 

To make all fields on an add screen sticky: 

1. Go to the Add Screen 

2. Select All Sticky from the Edit menu. 

The text beside each Sticky field changes from black to color, indicating that all fields are Sticky. 

To reset a sticky field to not-sticky, 

• Click on the text beside the field. 

The colored text beside the Sticky field reverts to black text, indicating that the field is no longer 
Sticky. 
 
Intelligent Fields 

Intelligent fields are fields that recognize, and fill in, previously entered information. 
 

 
 
As you type the first characters of your entry into an intelligent field such as Author, Publisher, 
Binding, etc., HomeBase 2 searches the drop-down list and supplies the first alphabetic match. 
Matches appear as highlighted text in the field. If the match does not provide the information you 
wish to enter, continue typing over the highlighted text. With each character that you type, 
HomeBase 2 narrows the options until a matching entry appears in the field. If the matched entry 
is not the one you want, type the complete entry. In some cases, there may be information left 
over such as if you typed King and Kingston was being displayed. To delete the remaining 
information press the Delete key. 
 
If you have entered information that HomeBase 2 does not recognize such as an entry which was 
not already in your database, the new entry will be added to the drop-down list when you move 
from the field. The next time you begin to enter the same information in the same field, 
HomeBase 2 will match your entry with this new information. 
 
Some intelligent fields are not capable of adding, modifying, or deleting items from their drop-
down lists at all. For instance, the Book Status field on the Books Screen does not accept new 
entries into its drop-down list. This field can only display entries that have been assigned by 
HomeBase 2 to its drop-down list. 
 
Some intelligent fields require confirmation and/or additional information before adding new 
entries to their drop-down lists. For instance, if you type a new edition type in the Edition field of a 
book, HomeBase 2 opens and asks you to provide more information before the new edition is 
added to the list of edition types.  

Most intelligent fields in HomeBase 2 have an Edit button . List items may be modified or 
deleted directly from the drop-down list. 
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To select an item from a drop-down list: 

1. Click on the Arrow button to open the drop-down list. 
2. Click on an item from the drop-down list to select it. Once you have clicked on an item, 

the list closes and the selected item appears in the current field. 

To edit the drop-down list of an intelligent field: 

1. Click the Arrow button beside the field you wish to edit. The drop-down list appears. 
2. Click the entry you wish to modify or delete. The selected entry appears in the field. 
3. Click the Edit button beside the field. The Edit List Screen appears. 
4. Modify the entry or click Remove. You may also select either of the following options: 

• Automatically format to proper case if you want HomeBase 2 to assign proper 
casing to your entry, OR 

• Only allow entries that match list items if you want HomeBase 2 to match entries 
with existing entries in the list. You will not be able to add any more items to the 
list. 

5. Click Done. 
 

Search-As-You-Type 

The fields in the Find Boxes, at the top of the List Screens (Books screen, Clients screen, etc.) 
are Search-As-You-Type fields. 

As you type information into these fields, HomeBase 2 matches any entered information and 
displays a list of matches in the lower part of the screen. For example, if you are searching for a 
client whose name is Fred Smith, go to the Find Client Box (at the top of the Clients Screen) and 
begin by typing the letter ‘F’ in the Name field. The Client List Screen displays all the clients in 
your database whose names begin with ‘F’. With each character that you type, the list narrows 
(All clients whose names begin with ‘Fr", then all clients beginning with ‘Fre’). 

Depending on the contents of your database, you may only need to type a few characters in order 
to find the desired client, book, want or invoice.  

Auto-Sort on Find Screens 

To sort fields on any find screen, click the header (the name of the field) at the top of the column 
that you want to sort by. The data will now be sorted in ascending order by that column. If you 
would rather sort the column in descending order, click one more time on the column header. 
 

 
 

Note:  

• Some fields cannot be sorted; these are the long text fields such as descriptions or 
notes. 
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Save/New Button 

You can save time while entering information by using the Save/New button when you are adding 
multiple books, clients, invoices, catalogs, or wants. 

When you have completed an add and wish to continue adding, click the Save/New button to 
refresh the Add Screen and prepare for another add. 

Use Sticky fields to retain information after each add if you are adding entries that share common 
properties (e.g. several books by the same author, or from the same publisher). 

Backing Up Your HomeBase 2 Data 

HomeBase 2 has a backup feature so that if your data is lost it can be recovered. When you close 
HomeBase 2 you are automatically prompted to do a back up, however, if you wish to you can 
perform a backup while in HomeBase 2. The procedures are the same regardless of how the 
backup function is initiated. 

To perform a backup while in HomeBase 2: 

1. Select File from the menu bar and click Backup. The Backup HomeBase 2 Data to… 
dialog box is displayed.  

2. HomeBase 2 automatically generates a backup name and places the file in the backup 
folder of HomeBase 2. If you wish, you can select a different file name or file location. 
Click Save. 

3. A progress screen displays the state of the backup. When the backup is complete, the 
Backup Data dialog box is displayed. Click OK.  

 
Recovering Your HomeBase 2 Data 

HomeBase 2 has a Recover feature, which will restore backed up data from HomeBase 2. Do 
NOT use this feature to recover data from earlier versions of HomeBase 2. Instead, use the Load 
HomeBase v1 Data command from the Tools menu to recover data from an earlier version of 
HomeBase. 

Warning: When you recover your HomeBase 2 data, any existing data in HomeBase 2 will be 
deleted and replaced with the recovered information. 

To recover your HomeBase 2 data: 

1. Select File from the menu bar and click Recover. The Recover HomeBase 2 Data to… 
dialog box is displayed. 

2. HomeBase 2 automatically selects the most recent back up file from the HomeBase 2 
backup file. If you wish, you can select a different file or select a folder from a different 
location.  

3. Click Open. 
4. A progress window displays the state of the recovery process. When the recovery if 

complete the Recover dialog box is displayed.  
5. Click OK. The Auto-Generate Book Numbers screen is displayed. 
6. If you would like HomeBase 2 to generate book numbers for you click Yes. If you do not 

want to use this feature, and would rather enter book numbers manually, click No. 
 

Opening a Web Browser 
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HomeBase 2 has a feature whereby you can open a web browser directly from HomeBase 2. 
When the browser opens it displays the Abebooks homepage.  
 
To go directly to the Abebooks search screen see Finding Books on Abebooks. 
 

• Select Tools from the menu bar and click Web Browser. Your default browser opens 
displaying the Abebooks homepage. 

 
Shortcuts Using the Right Mouse Button 

As with many Windows applications, HomeBase 2 gives you a list of shortcut features using the 
right mouse button.  
 

1. Place your cursor over the data on any of the Find screens and click the right mouse 
button. A shortcut list of actions is displayed. For example, if you are on the: 

• Find invoices screen and you right mouse click over the list of invoices you can 
list the total for the current list of invoices. 

• Find books screen and you right mouse click over the list of books you can mark 
selected books as sold or add selected books to a new invoice in addition to 
other options. 

Note:  

• You can also right mouse click on the fields of add or update screens to bring up a list 
of functions such as undo, cut, copy etc. 

MANAGING BOOKS 

Managing Books 

To get to the Books screen from anywhere in HomeBase 2, go to the spine at the left side of your 
screen and click on Books. The spine provides an easy way to navigate between screens, and is 
visible whenever you use HomeBase 2. You can also get to the Books screen by going to the 
View menu at the upper left corner of your screen, and selecting Books. 

From the Books Screen, you can: 

Add a Book 
Adding a Book Using ISBN Lookup  
Delete Books 
Find a Book in your database  
View detailed information about a Book  
Updated Book information 
How to Manage Sold Books  
View all Books in your database  
View All Books In Stock  
View all "For Sale" Books  
View all Sold Books  
View all "On Hold" Books  
Attach a Book to a Catalog  
Remove a Book from a Catalog  
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Find a book on the Advanced Book Exchange  
 

 
 
Finding Books 

Finding a Book 

1. Click Books on the Abebooks spine. The Find Books screen is displayed.  
2. Type all or part of the author/illustrator name, title, publisher etc. As you type, a list of 

possible matches appears beneath the Find Box. If no matches are found, the list 
appears empty. 

Note:  

• When you search you can use Wildcards. 

3. There are several options for searching:  
• By default, HomeBase 2 is set to search through all books; however, you can 

limit the search to books for sale, books on hold, sold books etc., by clicking one 
of radio buttons on the right side. 

• You can list all books by clicking Show All. 
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• You can search Abebooks for the book(s) by clicking Search ABE. Your internet 
browser will display the results of the search as if you had searched directly on 
Abebooks. 

 
Searching in the Keywords Field 

All of the fields in the Find Box, except the Keywords field, search for matches only within their 
own/same categories. The Keywords field seeks matches in the Keywords fields as well as in 
both of the Comments fields. For example, if you type "Coffee" into the Keywords field, the list of 
matches may contain books with "Coffee Stain" in the comment field, books with "Coffee Table" 
as a descriptive comment, and any books with "Coffee" as a keyword. 

 
Finding a Book on Abebooks 

1. Click Books on the Abebooks spine. The Find Books screen is displayed.  
2. Type the book information into the Find Book section at the top of the screen. 
3. Click on Search ABE. Your browser opens displaying all books matching the search 

criteria, just as if you had performed the search directly on Abebooks. 

Note: 

• To search Abebooks from HomeBase 2, you must have an Internet connection. 
 
Viewing Books 

Viewing Detailed Information About a Book 

1. Click Books on the Abebooks spine. The Find Books screen is displayed. 
2. Select the book you wish to view. For more on finding books, see Find A Book. 

3. Click the Update Icon  or double-click the desired book. 
4. The Edit Books Screen displays all the current information for the selected book. 
5. From this screen you can 

• Update Book Information 
• Click Cancel to leave Edit Books Screen and return to the book list. 

 

Viewing All Books on HomeBase 2 

1. Click Books on the Abebooks spine. The Find Books screen is displayed. 
2. Click Show All. A list of all the titles currently on HomeBase 2, regardless of status such 

as On Hold, For Sale, etc. is displayed. 

Note: 

• Books are listed numerically by Book #. To list books alphabetically by Author, 
Publisher, or other criteria, see Auto -Sorting.  

 
Viewing All Books In Stock 

1. Click Books on the Abebooks spine. The Find Books screen is displayed. 
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2. Click For Sale/ On Hold. A list of all the books currently in stock or all books currently For 
Sale or On Hold is displayed. 

Note: 

• Books are listed numerically by Book #. To list books alphabetically by Author, 
Publisher, or other criteria, see Sorting.  

 
Viewing All Sold Books 

1. Click Books on the Abebooks spine. The Find Books screen is displayed. 
2. Click Sold. A list of all the sold titles is displayed. 

Note: 

• Books are listed numerically by Book #. To list books alphabetically by Author, 
Publisher, or other criteria, see Sorting.  

Viewing All "On Hold" Books 

1. Click Books on the Abebooks spine. The Find Books screen is displayed. 
2. Click On Hold. A list of all the books on hold is displayed. 

Note: 

• Books are listed numerically by Book #. To list books alphabetically by Author, 
Publisher, or other criteria, see Sorting. 

Viewing All "For Sale" Books 

1. Click Books on the Abebooks spine. The Find Books screen is displayed. 
2. Click For Sale. A list of all the titles currently on for sale is displayed. 

Note: 

• Books are listed numerically by Book #. To list books alphabetically by Author, 
Publisher, or other criteria, see Sorting.  

Adding, Updating and Deleting Books 

Adding a Book 

1. Click Books on the Abebooks spine. The Find Books screen is displayed.  
2. Click the Add icon . 
3. Type the book information.  

• Many of the fields have drop-down lists to reduce the amount of typing and 
speed up data entry. Just click on the arrow and click the option that describes 
the book, or type the information and the list of possibilities is narrowed. See 
Intelligent Fields below. 

•  You can attach a book to a catalog. For more information refer to: Attaching a 
book to a catalog. 

4. Click the ‘Save’ button to save the information and return to the Find Books screen or 
click the ‘Save/New’ button to save the book and add another book. 
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HomeBase 2 assigns each new entry a Book #, which appears in the first field ("Book #"). You 
may choose to assign your own Book #s, as long as each Book # is unique. To do this, go to the 
Options screen. 

Intelligent Fields 

• Most fields on this screen are Intelligent Fields, which recognize, and fill in, previously 
entered information. 

• An Intelligent Field is identified by the arrow and the pencil to the right of the field. 
• As you type the first characters of your entry, HomeBase 2 searches in the drop-down list 

for matching entries. The first alphabetically matched entry appears in the field as 
highlighted text. If the matched entry is the one that you want, TAB to the next field. The 
matched item remains in the field. 

• If the matched entry is not the one you want, continue typing your entry. HomeBase 2 will 
add the new item to the drop-down list for future use. Some fields will prompt you to 
confirm the addition of the new item and to provide additional information for Abebooks 
searches. 

Note: 

• You may turn the "intelligent" field option off for the author and/or publisher fields by 
clicking on the Options icon in the toolbar and selecting the Editing tab. Remove the 
check mark in front of the option that you wish to turn off. 

Keywords 

HomeBase 2 uses words entered in the Keywords field to locate books from the Find function. 
Enter keywords, which describe the content or category of a book, so that books may be easily 
located during future searches. 

Note: 

• The keyword field in HomeBase 2 allows you to enter an almost unlimited amount of 
characters, but only the first 2,000 characters will be saved with your online inventory 
on abebooks.com. 

Entering Book Cost/Price 

• Whole currency amounts only require a single number. HomeBase 2 automatically 
converts the entered number to a currency amount when you leave the field. 

• To enter a partial currency amount, you are required to enter the decimal point after the 
whole currency amount. (For example, to enter $8.25, type 8.25. HomeBase 2 will 
convert a whole number to a whole currency amount.) 

• You do not need to enter a currency sign such as the $. 
• When you move from the field, HomeBase 2 automatically formats the entered number 

as a currency amount. 
• Amounts entered into the "My Cost" field will appear only on your own copy of HomeBase 

2. They will not be displayed on Abebooks, and will not be accessible to other Abebooks 
users. 

Adding A Book Using ISBN Lookup 

This service is only available to www.abebooks.com member booksellers. It is requirement to be 
connected to the Internet for this function to work! 
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Disclaimer: 
 
All information retrieved through the ISBN Lookup should be verified for accuracy. Occasionally, 
discrepancies do occur between the information retrieved and the information contained within the 
book (e.g. change in publisher name after the date of publication). It is the bookseller's responsibility 
to ensure that all information is correct.  Abebooks does not guarantee the accuracy of the 
information as third parties provide it. 

Abebooks uses Bowker.com to supply the ISBN data used in our lookup feature. 

The ISBN Lookup enhancement enables registered abebooks.com booksellers to catalogue their 
books much more conveniently and quickly. 

When an ISBN Lookup number is entered, HomeBase 2 automatically retrieves some of the 
book's associated information (e.g. author, illustrator, publisher, etc.) and displays it in the 
appropriate field boxes. Other information required to list the book, such as condition and edition, 
is entered manually. 

1. Click Books on the Abebooks spine. The Find Books screen is displayed.  

2. Click the Add icon . 
3. Type the ISBN number into the ISBN Lookup field. 
4. Click the ‘ISBN Lookup’ button to retrieve book Information from abebooks.com. 

Note:  

• Any field that you filled in previously will not be updated when the ISBN Lookup is 
used. 

5. Fill in the rest of the information about your book. You can move from field to field by 
using the ‘Tab’ key. 

6. Click the ‘Save’ button to save the information and return to the Find Books screen or 
click the ‘Save/New’ button to save the book and add another book. 

Setting ISBN Preferences 

ISBN Preferences can be set to determine which information you wish to receive. 

1. Click the ‘ISBN Preferences’ button. This will connect you to abebooks.com. 

2. Choose your ISBN Preferences. 

Book # 

HomeBase 2 assigns each new entry a Book #, which appears in the first field on the left, labelled 
("Book #"). You may choose to assign your own Book #s, as long as each Book # is unique. To 
do this, go to the Options screen. 

Intelligent Fields 

• Most fields on this screen are Intelligent Fields, which recognize, and fill in, previously 
entered information. 

• An Intelligent Field is identified by the arrow and the pencil to the right of the field. 
• As you type the first characters of your entry, HomeBase 2 searches in the drop-down list 

for matching entries. The first alphabetically matched entry appears in the field as 
highlighted text. If the matched entry is the one that you want, TAB to the next field. The 
matched item remains in the field. 
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• If the matched entry is not the one you want, continue typing your entry. HomeBase 2 will 
add the new item to the drop-down list for future use. Some fields will prompt you to 
confirm the addition of the new item and to provide additional information for Abebooks 
searches. 

 
Keywords 

HomeBase 2 uses words entered in the Keywords field to locate books from the Find function. If 
ISBN keywords are available ISBN Lookup will enter keywords, which describe the content or 
category of a book, so that books may be easily located during future searches. You may add or 
delete these keywords. 

Note:  

• The keyword field in HomeBase 2 allows you to enter an almost unlimited amount of 
characters, but only the first 2,000 characters will be saved with your online inventory 
on abebooks.com. 

Entering Book Cost/Price 

• Whole currency amounts only require a single number. HomeBase 2 automatically 
converts the entered number to a currency amount when you leave the field. 

• To enter a partial currency amount, you are required to enter the decimal point after the 
whole currency amount. (For example, to enter $8.25, type 8.25. HomeBase 2 will 
convert a whole number to a whole currency amount.) 

• You do not need to enter a currency sign such as the $. 
• When you move from the field, HomeBase 2 automatically formats the entered number 

as a currency amount. 
• Amounts entered into the "My Cost" field will appear only on your own copy of HomeBase 

2. They will not be displayed on Abebooks, and will not be accessible to other Abebooks 
users. 

 
Cloning Book Information 

This feature allows you to duplicate existing book information and modify it to reduce time in data 
entry. 

1. Click Books on the Abebooks spine. The Find Books screen is displayed. 
2. Select the book you wish to clone. 
3. Select File from the menu bar and click Add clone of current Book. The Book screen is 

displayed with all of the book information copied from the chosen book. 
4. Update the book information if required. 
5. Click Save. 

 
Deleting a Book 

1. Click Books on the Abebooks spine. The Find Books screen is displayed. 
2. Select one or more books from the Book List. To select multiple books hold down the Ctrl 

key while clicking with the mouse. 

3. Click the Delete icon  on the toolbar to delete the selected book(s). 
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4. A window appears asking you to confirm that you wish to delete the selected book. This 
window displays detailed Book information, including Comments, so that you can confirm 
that this is the copy you wish to delete. Do one of the following: 

• Click Yes to complete the delete 
• Click Yes to All if you wish to delete multiple books without further confirmation 

Note:  

• Once a book has been deleted from HomeBase 2, the record is permanently removed 
from HomeBase, but not from Abebooks. If you delete a book from HomeBase then 
send your updates, the book will still be listed on Abebooks. 

In order to remove the book from your online inventory, please mark it as "sold" in HomeBase 2 
instead of deleting it. See "How to Manage Sold Books" in the Managing Books section. 
 

Deleting Books Attached to Invoices 

You may not delete a book that appears on an invoice, unless you delete or modify the invoice 
first. If you attempt to delete a book that appears on an invoice, a window appears, displaying the 
Invoice # that the book is attached to. 

• Click OK to close the window. 
 
For instructions on deleting or modifying an invoice, see: Delete an Invoice or Update an Invoice 
 
Updating a Book  

1. Click Books on the Abebooks spine. The Find Books screen is displayed. 
2. Select the book you wish to update. For more on finding books, see Find A Book 
3. Click the Update Icon  or double click the desired book.  
4. Move to the field you wish to edit information in. 
5. Type the new information. 
6. Click Save to save your changes. 

 
Books and Catalogs 

Attaching a Book to a Catalog/ to Multiple Catalogs 

1. Click Books on the Abebooks book spine. The Find Books screen is displayed. 

2. Select the book you wish to add to the catalog and click the Update icon  or double 
click the desired book. 

3. Click Attach Books, at the bottom of the Edit Books Screen. The Choose Catalogs screen 
appears. 

4. Select the catalog(s) you wish to attach the book to and Click OK. The Books screen is 
displayed. The new catalog(s) appears in the window in the Catalog Box, at the bottom of 
the Edit Books Screen. The book has been successfully attached to the new catalog(s). 

5. Click Save. 

Note: 

• You may attach a book to more than one catalog in HomeBase 2. If your books are 
attached to more than one catalog when you upload your books however, Abebooks 
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can only associate your book online with one catalog and will select the catalog with 
the lowest catalog reference #. To view the catalog reference number, click Catalogs 
on the Abebooks book spine. The catalog ID is the reference number. 

Removing Books from a Catalog 

1. Click Books on the Abebooks spine. The Find Books screen is displayed. 

2. Select the book you wish to remove from the catalog and click the Update icon  or 
double click the desired book. The Books screen is displayed. 

3. Select the catalogs you wish to remove the book from. Note: Catalogs are listed in the 
Catalog Box, at the bottom of the Edit Books Screen. 

4. Click Remove. 
5. Click Save.   
 

How to Manage Sold Books 

To remove (delete) books from the abebooks.com online system using HomeBase 2, you must 
change the status of sold books to "Sold" and send these changes to abebooks.com. 

Some booksellers accidentally delete (remove) their books from HomeBase 2 and then upload 
their data to abebooks.com believing that abebooks.com will automatically recognize the book is 
gone. This will NOT happen because abebooks.com and HomeBase 2 are completely separate 
from each other. 

When you send a file of "Sold" books, abebooks.com matches those book numbers against the 
ones already online. When it reads (say) book #1234 is marked as "Sold" it removes (deletes) the 
listing from abebooks.com. 

It is imperative you send sold books to abebooks.com on a regular basis. 

To recognize "Sold" books in HomeBase 2, choose the books that need to be marked as sold 
from the book list by double clicking the book in question. 

When the book record opens, change the status field to 'Sold' and click 'Save' to mark the book 
as 'Sold.' 

Note:  

• To select multiple items in a list, hold down the [Ctrl] key and click on the leftmost 
column of the row (the gray area to the left of the BookNumber field). Repeat this for 
each item you wish to select. When you are selecting items you must ensure the 
background color is blue. If the background is black that item is NOT selected. 

Right-click your mouse and choose "Mark selected Books as Sold". 

The best way to keep track of "Sold" books in HomeBase is to create a 'Sold' catalogue and 
move all "Sold" books into it. 

1. Click 'Catalogs' on the abebooks.com spine. 
2. Create the "Sold" catalog. 
3. Return to 'Books'. 
4. Right-click and select "Move all sold books to" 
5. Choose the 'Sold' catalogue and click [OK]. 

All books marked "Sold" will now be moved into your 'Sold' catalogue. 
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You are now ready to send this information to abebooks.com. In "Send Data to abebooks.com" 
click 'Selected Catalogs' and choose the Sold catalogue by using [Add] and [OK]. Click [Send] 
and save the file. Then proceed to upload the file in the usual manner. 

Managing Catalogs 

Managing Catalogs 

To get to the Catalog screen from anywhere in HomeBase 2, go to the spine at the left side of 
your screen and click on Catalogs. The spine provides an easy way to navigate between screens, 
and is visible whenever you are using HomeBase 2. You can also get to the Catalogs screen by 
going to the View menu at the upper left corner of your screen, and selecting Catalogs. 

From the Catalog Screen, you can: 

Add a Catalog  
Delete a Catalog  
Attach Books to a Catalog  
Remove Books from a Catalog  
Move All Books from one Catalog to another Catalog  
Move Selected Books from one Catalog to another Catalog  
Copy All Books from one Catalog to another Catalog  
Copy Selected Books from one Catalog to another Catalog  
Mark Selected Books as Sold  
Update Catalog Name and Description  
 

 
Adding, Updating and Deleting Catalogs 
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Adding a Catalog 

1. Click Catalogs on the Abebooks spine. The Catalogs screen is displayed. 

2. Click the Add  icon. The Add Catalog box is displayed. 
3. Type the catalog information. 
4. Click Save. 

 
Assigning Catalog Names 

You cannot assign the same name to more than one catalog. If you assign a Catalog Name that 
is already in use, the "Duplicate Catalog Name" window opens, informing you that the Catalog 
Name is already in use. 
 
Deleting a Catalog 

1. Click Catalogs on the Abebooks spine. The Catalogs screen is displayed. 

2. Select the catalog(s) you wish to delete and click the Delete icon . The Delete 
Box is displayed. 

3. Click Yes. All books currently attached to the catalog are removed. 
 
Updating Catalog Name and Description 

1. Click Catalogs on the Abebooks spine. The Find Catalogs screen is displayed. 
2. Select the catalog whose name or description you wish change and click the Update icon 

 or double click the desired catalog. 
3. If you are changing the: 

• Name, click Rename and type a new name. 
• Description, type a new description. 

4. Click Save. 
 

Attaching a Book(s) to a Catalog 

1. Click Catalogs on the Abebooks book spine. The Find Catalogs screen is displayed. 

2. Select the catalog you wish to attach books to and click the Update  icon or double 
click the desired catalog. The Catalogs screen is displayed. 

3. Click Attach Books. The Select Books screen appears. 
4. Select the book(s) you wish to attach and click OK. To select multiple books hold the Ctrl 

key while selecting books. A message is displayed saying that the book has been added. 
Click OK. 

5. Click Close. 

Note: 

• You can attach a book to more than one catalog in HomeBase 2. If your books are 
attached to more than one catalog when you upload your books however, Abebooks 
can only associate your book online with one catalog and will select the catalog with 
the lowest catalog reference #. To view the catalog reference number, click Catalogs 
on the Abebooks book spine. The catalog ID is the reference number.  

Removing Books from a Catalog 
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1. Click Catalogs on the Abebooks spine. The Find Catalogs screen is displayed.  

2. Select the catalog you wish to remove books from and click the Update icon  or 
double click the desired catalog. 

3. Select the book(s) you wish to remove from the catalog and click Remove Selected 
Books. To select multiple books hold the Ctrl while selecting books. The Remove Books 
dialog box is displayed.  

4. To confirm the removal of the books from the catalog, click Yes. The removed book(s) 
disappears from the Edit Catalog Screen. The Catalogs screen is displayed.  

5. Click Close. 

Note:  

• The book(s) is not deleted from your inventory. It is only removed from that catalog. 

Marking Selected Books as Sold 

1. Click Catalogs on the Abebooks spine. The Find Catalogs screen is displayed. 
2. Select the catalog(s) you wish to mark books in. 

3. Click the Update icon  or double click the desired catalog.  
4. Select the Edit Catalog Book List. 
5. Select the book(s) you wish to mark as Sold and click Mark Selected as Sold. To select 

multiple books, hold the Ctrl key while selecting the books. 
6. The status of the selected books is changed to Sold. If a selected book was already 

marked as Sold, its status remains the same. 
7. Click Close. 

 
Advanced Catalog Functions 

Copying Selected Books from one Catalog to Another Catalog 

1. Click on Catalog on the Abebooks spine. The Find Catalogs screen is displayed. 

2. Select the catalog you wish to copy books from and click the Update icon  or double 
click the desired catalog. The Catalogs screen is displayed. 

3. Click the Edit Catalog Book List tab.  
4. Select the book or books you wish to copy from the book list. To copy more than one 

book, hold down the Ctrl key while selecting books.  
5. Click the Advanced Functions tab.  
6. Select Copy selected books from this catalog from the drop down list beside Action to 

Perform.  
7. From the To Catalog drop down list, select the catalog you wish to copy the books to.  
8. Click Do It. All selected books are copied from the current catalog (the one that you are 

editing) to the selected catalog. If a book is already attached to the new catalog, it will not 
be duplicated in the new catalog. 

9. Click Close. 
  
Copying All Books from one Catalog to Another Catalog 

1. Click on Catalog on the Abebooks spine. The Find Catalogs screen is displayed. 

2. Select the catalog you wish to copy books from and click the Update icon  or double 
click the desired catalog. The Catalogs screen is displayed. 
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3. Click the Advanced Functions tab.  
4. Select Copy all books from this catalog from the drop down list beside Action to Perform.  
5. From the To Catalog drop down list, select the catalog you wish to copy the books to.  
6. Click Do It. All books are copied from the current catalog (the one that you are editing) to 

the selected catalog. If a book is already attached to the new catalog, it will not be 
duplicated in the new catalog. 

7. Click Close. 
 

Moving Selected Books from one Catalog to Another Catalog 

1. Click Catalogs on the Abebooks spine. The Find Catalogs screen is displayed. 

2. Select the catalog you wish to move books from and click the Update icon  or double 
click the desired catalog. 

3. Select the books you wish to move from the catalog. To select multiple books hold down 
the Ctrl key while selecting books. 

4. Click the Show Advanced Functions tab. 
5. Select Move Selected Books from the drop-down list beside Action to Perform. 
6. From the To Catalog drop down list, select the catalog that you want to move books to.  
7. Click Do It. All books are removed from the current catalog and attached to the selected 

catalog. If a book is already attached to the new catalog, it will remain there. 
8. Click Close. 

Note:  

• You may not move books from the "All" catalog. 

Moving All Books from One Catalog to Another Catalog 

1. Click Catalogs on the Abebooks spine. The Find Catalogs screen is displayed. 
2. Select the catalog you wish to move books from and click the Update icon  or double 

click the desired catalog. 
3. Click the Show Advanced Functions tab. 
4. Select Move All Books from the drop-down list beside Action to Perform. 
5. From the To Catalog drop down list, select the catalog that you want to move books to.  
6. Click Do It. All books are removed from the current catalog and attached to the selected 

catalog. If a book is already attached to the new catalog, it will remain there. 
7. Click Save.  

Note:  

• You may not move books from the "All" catalog. 

Moving all Sold Books from One Catalog to Another Catalog 

There are two ways to move sold books to another catalog: 
• Move all sold books to another catalog 
• Move all sold books from one catalog to another catalog. 

There is an important difference in the way that each of these two functions operates. The Move 
all sold books to another catalog moves sold books from ALL catalogs to a specified catalog while 
the Move all sold books from one catalog to another catalog moves sold books within a specific 
catalog to another catalog.  
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If you follow the steps below, your sold books from a selected catalog will be moved to the 
catalog you specify. 

1. Click Catalogs on the Abebooks spine. The Find Catalogs screen is displayed. 

2. Select the catalog you wish to move sold books from and click the Update icon  or 
double click the desired catalog. 

3. Click the Show Advanced Functions tab. 
4. Select Move All Sold Books from the drop-down list beside Action to Perform. 
5. From the To Catalog drop down list, select the catalog that you want to move books to. 
6. Click Do It. All sold books are removed from the current catalog and attached to the 

selected catalog. If a book is already attached to the new catalog, it will remain there. 
7. Click Close. 

Note:  

• You may not move sold books from the "All" catalog. 

Moving all Sold Books to Another Catalog 

There are two ways to move sold books to another catalog: 
• Move all sold books to another catalog 
• Move all sold books from one catalog to another catalog. 

There is an important difference in the way that each of these two functions operates. The Move 
all sold books to another catalog moves sold books from ALL catalogs to a specified catalog while 
the Move all sold books from one catalog to another catalog moves sold books within a specific 
catalog to another catalog.  

If you follow the steps below, all of your sold books from all catalogs will be moved to the catalog 
you specify. 

1. Select Tools from the Menu bar and click "Move all sold books to…" The Move All Sold 
Book To… dialog box is displayed.  

2. Select the catalog you wish to move sold books from and click the OK. The Finished 
Moved screen displays the number of books in the specified catalog. 

 
MANAGING WANTS 

Managing Wants 

To get to the Wants screen from anywhere in HomeBase 2, go to the spine at the left side of your 
screen and click on Wants. The spine provides an easy way to navigate between screens, and is 
visible whenever you are using HomeBase 2. You can also get to the Wants screen by going to 
the View menu at the upper left corner of your screen, and selecting Wants. 

From the Wants Screen, you can: 

Enter a new Want  
Find a Want  
Edit a Want  
Add a new Client to a New Want  
View all Wants for a particular Client  
List all Wants  
Delete a Want  
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Print a Want  
Print all Wants for a Particular Client  
Print all Wants  
Send Wants to Abebooks!  
 

 
Viewing Wants 

Viewing Wants 

1. Click on Wants on the Abebooks spine. The Find Wants screen is displayed showing all 
current wants. 

2. If you want to:  
• Find a particular want, type the relevant information for the Author, Title, 

Publisher fields at the top. The matching wants are displayed. As you type, a list 
of possible matches appears beneath the Find Box. If no matches are found, the 
list appears empty. See Search as You Type for more information. 

• Display all wants, click Show All to view a complete list of wants or to start a new 
search. 

Viewing All Wants For A Client 

1. Click Clients on the Abebooks spine. The Find Clients screen is displayed. 
2. Select the client you wish to edit. For help on finding clients, see Find A Client. 
3. Click the Update icon . The Clients screen is displayed.  
4. All current wants for the selected client are displayed in the Wants For This Client box.  
5. Click Save to return to the Clients Screen. 

  
Finding Wants 

Finding a Want 

1. Click on Wants on the Abebooks spine. The Find Wants screen is displayed.  
2. If you want to:  

• Find a particular want, type the relevant information for the Author, Title, 
Publisher fields at the top. The matching wants are displayed. As you type, a list 
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of possible matches appears beneath the Find Box. If no matches are found, the 
list appears empty. 

Note:  

• You can use wildcards in your search. For more information see Wildcards 

• Display all wants; click Show All to view a complete list of wants or to start a new 
search. 

  
Adding, Updating and Deleting Wants 

Adding a New Client to a Want 

1. Click on Wants on the Abebooks spine. The Find Wants screen is displayed. 

2. Click the Add  icon. The Wants screen is displayed. 
3. Click the + beside the client box. The Add Client screen is displayed. 
4. Type the name and phone number of the new client. Click Save. 
5. Type the information for the want and click Save. 
 

Adding a Want for a Client 

1. Click Wants on the Abebooks spine. The Find Wants screen is displayed. 

2. Click on the Add button . 
3. Type the information for the want. 
4. Do one of the following: 

• Click Save to save the want. 
• Click Save/New to save the want. 
 

Cloning Want Information 

This feature allows you to duplicate existing want information and modify it to reduce time in data 
entry. 

1. Click Wants on the Abebooks spine. The Find Wants screen is displayed. 
2. Select the want you wish to clone. 
3. Select File from the menu bar and click Add clone of current Want. The Want screen is 

displayed with all of the book information copied from the chosen want. 
4. Update the want information if required. 
5. Click Save. 
 

Deleting a Want 

1. Click Wants on the Abebooks spine. The Find Wants screen is displayed.  

2. Select the want(s) you wish to delete and click the Delete icon . To select multiple 
wants, see Selecting Multiple Items in a List. The Delete dialog box appears. 

3. Click Yes to delete the want(s). 
  
Updating a Want  
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1. Click Wants on the Abebooks spine. The Find Wants screen is displayed. 
2. Select the want you wish to edit and click the Update icon  or double click the desired 

want. 
3. Enter the changes you wish to make to the want. 
4. Click Save. 
  

Viewing All Wants for a Client 

1. Click Wants on the Abebooks spine. The Find Wants screen is displayed. 
2. Type the client’s name in the Clnt Name field. A list of the matched client’s wants is 

displayed. If no matching client is found, the want list appears empty. 
3. Click Show All to view a complete list of wants. 
 

MANAGING CLIENTS 

Managing Clients 

To get to the Client screen from anywhere in HomeBase 2, go to the spine at the left side of your 
screen and click on Clients. The spine provides an easy way to navigate between screens, and is 
visible whenever you are using HomeBase 2. You can also get to the Clients screen by going to 
the View menu at the upper left corner of your screen, and selecting Clients. 

From the Clients Screen, you can: 

Add a Client  
Delete a Client  
Find a Client  
Edit Client Information  
Print detailed information about a Client  
Add a Want for a Client  
Edit a Want for a Client  
View all Wants for a particular Client  
View detailed information about a Client  
Invoice a Client/Add a Client name to an Invoice  
View all Invoices for a particular Client  
View a List of all Clients  
Print a List of all Clients  
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Viewing Clients 

Viewing All Clients 

• Select Clients on the Abebooks spine. The Find Clients screen displays all clients 
currently in your database. 

Note: 

• Clients are listed numerically by Client #. To list clients alphabetically by Name, or 
other criteria, see Auto-Sort Sort. 

Viewing Detailed Information About a Client 

1. Select Clients on the Abebooks spine. The Find Clients screen is displayed. 
2. Select the client you wish to view. For more on finding clients, see Finding Clients. 

3. Click the Update icon  or double click on the desired client. The Clients screen opens 
displaying all current information for the client. 

4. Click Save to return to the Find Clients screen. 
 

Viewing All Invoices or Wants for a Client 
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1. Select Clients on the Abebooks spine. The Find Clients screen is displayed. 

2. Select a Client from the list and click the Update icon  or double click on the desired 
client. The Clients screen is displayed. 

3. Invoices and wants for the client are listed near the bottom of the screen  
4. To view, or update an: 

• Invoice, select the invoice from the Invoices for this Client box and click Edit. 
• Want, select the want from the Wants for this client box and click Edit. 
 

Finding Clients 

Finding a Client 

1. Click on Clients on the Abebooks spine. The Find Clients screen is displayed.  
2. If you want to: 

• Find a particular client, type the client name, phone number or address. As you 
type, a list of possible matches appears beneath the Find Box. If no matches are 
found, the list appears empty. See Search as you type 

Note:  

• You can use wildcards in your search. For more information see Wildcards. 

• Display all clients, click Show All. 

Note:  

• Clients are listed numerically by Client #. To list clients alphabetically by Name, or 
other criteria, see - Auto-Sort. 

Adding, Updating and Deleting Clients 

Adding a Client 

1. Click Clients on the Abebooks spine. The Find Clients screen is displayed. 

2. Click the Add icon . The Clients screen is displayed. 
3. Type the client information. When you enter a new client, HomeBase 2 automatically 

assigns a client number. 
4. Do one of the following: 

• Click Save to save the information and close the clients window. 
• Click Save/New to save the information and add another client. 

Updating Client Information 

1. Click on Clients on the Abebooks spine. The Find Clients screen is displayed. 
2. Select the client you wish to edit. For help on finding clients, see Find A Client. 

3. Click the Update icon  or double click on the desired client. The Clients screen is 
displayed. 

4. Edit the client information. 
5. Click Save. 
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Deleting a Client 

1. Click Clients on the Abebooks spine. The Find Clients screen is displayed. 
2. Select the client(s) you wish to delete. To select more than one client hold the Ctrl key 

down while clicking. 

3. Click the Delete icon . The Delete screen is displayed. 
4. The message "Delete the following Client?" appears. Do one of the following:  

• Click Yes to delete the client. 

• Click Yes to All to delete multiple clients without further confirmation. 

• Click No if you do not wish to delete the client. 

Deleting Clients Attached to Invoices 

You may not delete a client who appears on an invoice, unless you delete or modify the invoice 
first. If you attempt to delete a client who appears on an invoice, a window appears, displaying 
the number of invoices that the client is attached to. 

• Click "OK" to close the window. 
 

For instructions on deleting or modifying an invoice, see Delete an Invoice or Updating an Invoice 

Adding a Want for a Client 

1. Click Clients on the Abebooks spine. The Find Clients screen is displayed. 
2. Select the client you wish to edit. For help on finding clients, see Find A Client. 

3. Click the Update icon  or double click on the client. The Clients screen is displayed.  
4. Click the "Add" button beside the "Wants For This Client" box. The Wants Screen opens, 

displaying the selected client’s Information.  
5. Type the information for the want and click Save. The Clients screen is displayed with the 

new want. 
6. Click Save. 

 
Copying Information from the Book List 

If you are adding a want for a book that is already in your database, you can save time by 
copying book information from the book list. To do this: 

1. Click on the Arrow button beside the Title field in the Add Wants Screen. The book list 
appears, showing all books regardless of status (For Sale, On Hold, etc.).  

2. Select the desired title and click OK. The book information (title, author, publisher, and 
date of publication) appears in the Add Want Screen. 

 
Updating a Want for a Client 

1. Click Clients on the Abebooks spine. The Find Clients screen is displayed.  
2. Select the client you wish to edit. For more on finding clients, see Find a Client. 

3. Click the Update icon  or double click the client. The Clients screen is displayed. 
4. Select the want to be updated and click the Edit button beside the want for this Client box 

or double click the want. The Wants screen is displayed. 
5. Type the new information for the want and click Save. The Clients screen is displayed.  
6. Click Save to save the changes to the client.  
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Adding an Invoice for a Client 

7. Click Clients on the Abebooks spine. The Find Clients screen is displayed. 
8. Select the client you wish to edit. For help on finding clients, see Find A Client. 

9. Click the Update icon  or double click on the client. The Clients screen is displayed.  
10. Click the "Add" button beside the "Invoices for This Client" box. The Invoices screen 

opens, displaying the selected client’s information.  
11. Enter the information for the invoice and click Save. The Clients screen is displayed with 

the new invoice. 
12. Click Save.  
 

Updating an Invoice for a Client 

1. Click Clients on the Abebooks spine. The Find Clients screen is displayed.  
2. Select the client you wish to edit. For more on finding clients, see Find a Client. 

3. Click the Update icon  or double click the client. The Clients screen is displayed. 
4. Select the invoice to be updated and click the Edit button beside the invoice for this Client 

box or double click the invoice. The Invoice screen is displayed. 
5. Type the new information for the invoice and click Save. The Clients screen is 

redisplayed.  
6. Click Save to save the changes to the client.  
 

MANAGING INVOICES 

Managing Invoices  

To get to the Invoices screen from anywhere in HomeBase 2, go to the spine at the left side of 
your screen and click on Invoices. The spine provides an easy way to navigate between screens, 
and is visible whenever you are using HomeBase 2. You can also get to the Invoices screen by 
going to the View menu at the upper left corner of your screen, and selecting Invoices. 

From the Invoice Screen, you can: 

Create a new Invoice  
Find an Invoice  
Add a New Client to an Invoice  
Add Books to an Invoice  
Remove Books from an Invoice  
Update an Invoice  
Delete an Invoice  
View all Invoices for a Client  
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Viewing Invoices 

Viewing all Invoices for a Client 

1. Select Invoices on the Abebooks spine. The Find Invoices screen is displayed. 
2. Type the Client’s name in the Clnt Name field. All invoices associated with the client are 

displayed in the list below. 
3. Select the desired invoice from the list and click the Update icon . The invoices 

screen displays the invoice. 
 

Finding Invoices 

Finding an Invoice 

1. Click on Invoice the Abebooks spine.  
2. If you want to:  

• Find a particular invoice, type the relevant information for the client name, and/or 
select from to/from dates at the top of the screen. The matching invoices are 
displayed. As you type, a list of possible matches appears beneath the Find Box. 
If no matches are found, the list appears empty. See Search as you Type. 
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Note:  

• You can use wildcards in your search. For more information see Wildcards 

• Display all invoices, click Show All to view a complete list of invoices or to start a new 
search. 

• Invoices are listed numerically by Invoice #. To list invoices by Total, or by Date, see 
FEATURES-Auto-Sort.   

Adding, Updating and Deleting Invoices 

Adding an Invoice 

1. Click Invoice on the Abebooks spine. The Find Invoices screen is displayed. 

2. Click the Add icon . The Invoices screen is displayed. 
3. Select a customer from the Sold To drop down list, or click the + sign beside the list to 

add a new client.  
4. If desired, type the customer's address in the Ship To field. 
5. Click Add Books. The Select Books screen is displayed.  
6. Select the book or books to be sold and click OK. See Selecting Multiple Items in a List 

for more information. 
7. Select the method of payment and applicable taxes. HomeBase 2 automatically 

calculates the invoice total. 
8. Do one of the following: 

• Click Save/Print to save and print the invoice. 
• Click Save/New to save the invoice and begin a new invoice.  
• Click Save to save the invoice and return to the Invoice list. 

  
Updating an Invoice 

1. Click Invoices on the Abebooks spine. The Find Invoices screen is displayed. 
2. Select the invoice you wish to update and click the Update icon  or double click the 

desired invoice. 
3. Enter new information for the invoice. 
4. Click Save. 

  
Deleting an Invoice 

1. Click Invoices on the Abebooks spine. The Find Invoices screen is displayed. 

2. Select the invoice(s) you wish to delete and click the Delete icon . See Selecting 
Multiple Items in a List to select more than one invoice.  

3. Do one of the following: 
• Click Yes to delete the invoice 
• Click Yes To All to delete multiple invoices without further confirmation 

4. If a selected invoice has books attached to it, the Invoice dialog box is displayed notifying 
you that books are associated with the invoice and asking whether you want to put the 
books back into stock. Do one of the following:  

• Click Yes to return invoiced books to stock.  
• Click No to keep books as Sold. 
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Adding a New Client to an Invoice 

1. Click Invoices on the Abebooks spine. The Find Invoices screen is displayed. 

2. Click the Add icon . The Invoices screen is displayed. 

3. Click the Add icon  beside the Sold To field. The Add Client dialog box is 
displayed. 

4. Type the client information. 
5. Click Save. 

  
Adding Books to an Invoice 

1. Click Invoices on the Abebooks spine. The Find Invoices screen is displayed. 

2. Select the invoice you wish to add books to and click the Update icon  or double click 
the desired invoice. To select more than one invoice, see Selecting Multiple Items in a 
List. 

3. Click Add Books. The Select Books screen is displayed. 
4. Select the book(s) you wish to add to the invoice. Click OK. 
5. Do one of the following:  

• Click Save to save changes to the invoice 
• Click Save/Print to save the changes and print the invoice. 
 

Removing Books from an Invoice 

1. Click Invoices on the Abebooks spine. The Find Invoices screen is displayed.  

2. Select the invoice you wish to remove books from and click the Update icon  or 
double click the desired invoice. To select more than one invoice see, Selecting Multiple 
Items in a List . 

3. Select the book(s) you wish to remove from the invoice. 
4. Click Remove Books. 
5. Click Save. 

 
PRINTING AND REPORTS 

Printing 

HomeBase 2 allows you to print information in either Detail or List format. Detail format prints 
information in paragraphs, and List format prints information in a grid. 

You may choose to print the screen you are currently viewing, or to print all information from the 
List Screens (Books, Clients, etc.). 

Print Preview 

The print preview function works in the same manner regardless of whether you want to print 
books, catalogs, wants, clients or invoices.  

From any Find Screen, you can print the whole list or one selected item from the current list. You 
can print in either Detail (paragraph) or List (grid) format. 

1. Select Print Preview from the File menu. 
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2. Set the options in the Print Books (Catalogs, Wants, Clients, Invoices) screen. If you 
select: 

• Print  
• Current - prints the selected book, catalog, want etc. 
• List - prints the entire list of books, catalogs, wants etc.  

Note:   

• You can use the Find section to displays a shorter list of items. See Search as 
you Type for more information. 

• Format 
• List – lists the current information in a list style. 
• Detail – lists the current information, in detail format. 

3. Click OK to preview the information as it will print.  
4. Click Print to print the preview. The print dialog box is displayed.  
5. Click OK. 

 
Printing from the Find Screen 

The print function works in the same manner regardless of whether you want to print books, 
catalogs, wants, clients or invoices.  

From any Find Screen, you can print the whole list or one selected item from the current list. You 
can print in either Detail (paragraph) or List (grid) format. 

1. Click the Print icon on the toolbar.  
2. Set the options in the Print Books (Catalogs, Wants, Clients, Invoices) screen. If you 

select: 
• Print  

• Current - prints the selected books, catalog, want etc. 
• List - prints the entire list of books, catalogs, wants etc. See note below. 

• Format 
• List - prints the current information or list in a list style. 
• Detail - prints the current information or the list, in detail format. 

3. Click OK. The Print dialog box is displayed.  
4. Select your print options and click OK. 

Notes: 

• From the Invoice Screen, you can only print the current record, in Detail format. 

• If you have narrowed a search and only part of the list of items is displayed, only the 
items listed will be printed when you choose the List option for printing. If you wish to 
print the entire list, click Show All and then follow the steps above for printing. 

Printing from the Add/Edit Screens 

From any Add/Edit Screen in HomeBase 2, you can print the record you are adding or editing. 
The information will appear in Detail (paragraph) format. 

1. When you have finished adding or editing, click the Save/Print icon.  
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2. Click OK. The print dialog box is displayed. 
3. Click OK to print. 
 

Reports 

You can select the Print Reports function from any Find Screen. 
 

1. Click the Reports icon  on the toolbar. The Reports screen is displayed. 
2. Select the Type. You may choose to create a report on your:  

• Books 
• Catalogs 
• Wants 
• Clients 

3. If you wish to narrow the report to a particular catalog or client or some other criteria, type 
in more information in the Other box at the bottom of the screen. The fields displayed are 
dependent on which Type you chose. Note that you can use Wildcards. 

4. Select the Sort Order. The Sort Order determines how the information is displayed in the 
report. Note that the options depend on which Type you choose.  

5. Select the Options. Again the Options displayed depend on which Type is selected.  
• List – lists the current information in a list style. 
• Detail – lists the current information, in detail format. 
• By Client –lists the wants desired by each client. Only available if the Type: 

Wants is selected.  
• Labels – creates mailing labels for your clients. Only available if Type: Clients is 

selected.  
6. Click: 

• Print to print the report 
• View to see the report, as it would be printed. 
• Save As to save the file as an HTML file, Rich Text Format file, or as a Text file. 

  
Invoicing Totals Report 

HomeBase 2 has a unique feature whereby you can list the totals for all invoices displayed.  

1. Select Invoices from the Abebooks spine. The Find Invoices screen is displayed.  

Note:   

• You can use the Find section to reduce the list of invoices. See Search as you Type 
for more information. 

2. Right mouse click over the list of invoices. A shortlist is displayed. 
3. Select Totals for current list. A report is displayed showing the: 

• Number of invoices and books included on the report. 
• Selling price of the books 
• Taxes and shipping 
• Total book cost 
• Estimated profit 

4. You may:  
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• Save the report by clicking Save As. 
• Print the report by clicking Print. 

Statistics 

HomeBase 2 can create a report showing the current counts for books, catalogs, wants, clients 
and invoices in addition to the counts at the beginning of the session for each of the categories. 
The statistics for books are also broken down by the number of books for sale, on hold and sold. 

1. Select Tools from the menu bar and click Statistics. Your HomeBase 2 statistics are 
displayed. 

2. Click:  
• Print to print the statistics. 
• Save As to save the statistics as a text file. 
• Close to close the window. 
 

IMPORTING AND EXPORTING FILES 

Importing Files 

This is a feature that you will probably only use once, if at all. Its purpose is to import data after it 
has been converted from another source. 

1. Select File from the main menu and click Import/Export. 
2. Select Import and then select: 

• Merge to combine records of books that are already in your database with the file 
you are importing.  

• Zap to delete any previous records in your database and replace them with the 
data you are importing. This feature should only be selected if there is a problem 
with your current database. 

3. Click OK. 
4. Type a file name or select one from the list above and click Open. 

Notes:  

• To import files from the Abebooks site, you must have both an Internet connection 
and be a member (vendor) of Abebooks. 

• To start a vendor account, contact the Advanced Book Exchange. 

• Importing files from Abebooks or from any other source brings information in a slightly 
different format from the files in HomeBase 2. Although book information (i.e. Author, 
Title, Keywords, etc.) can be imported, other important information such as publishing 
information cannot always be divided into separate fields. The Import function should 
only be used as a start-up for a first-time user of HomeBase 2, or as an emergency 
data recovery measure. 

Exporting to a File 

1. Select Import/Export from the File menu.  
2. Select Export. The Export dialog box is displayed. 
3. Set your options for the export. If you are sending 

• Books you have the option of sending: 
• Books changed since a particular date.  
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• All Books or Selected Catalogs. If you choose to send Selected Catalogs 
you need to add the catalog to the list before sending. 

• Wants you can send all wants or wants changed since a particular date.  
4. Do one of the following: 

• Click OK to continue. 
• When you have selected your options click OK. The Export Books as dialog box 

is displayed. 
5. A file name for your books based on today's date is provided. If you wish you may 

change the file name.  
6. The file type of HomeBase 2 is automatically selected, however, you may change to a 

different file type by clicking on the arrow and a drop down list appears. You may choose 
another format such as Tab Delimited, Comma Delimited, or UIEE. 

7. Click Save. A progress bar is displayed when the export file is created. 

Note:  

• This is not the appropriate command to send your information to Abebooks. To send 
your information to Abebooks, use the Send to Abebooks command. 

Sending to Abebooks 

Sending to Abebooks 

To send data to Abebooks, you must have both an Internet connection and a vendor account with 
Abebooks. 

• To start a vendor account, contact the Advanced Book Exchange 
• To enter your UserID and password, go to the Setup Wizard or select View from the 

menu bar and select Options.  
   
You can send your data by FTP or by Email, however, we strongly recommend that you send 
your data using FTP since it is faster and no fewer restrictions on the size of file that you send.  
   
To send data by Email, you must define your Email server. You can enter your Email server 
(SMTP): 

• From the Setup Wizard 
• From Options  
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Send Data to Abebooks 

1. Click the Send to ABE icon . 
2. Type your UserID and password. If you entered your UserID and password in the Setup 

Wizard this information will already be entered and does not need to be entered again. 
3. Select the data you wish to send. For more information on which data to send see 

Options below.  
4. Select a Send By option (Email or FTP). 
5. Click Send. The Save ABE File Name dialog box appears with a file name already 

entered. 
6. Click Save. The Send to ABE dialog box is displayed showing how many books and 

wants will be sent to Abebooks.  
7. Click OK to create the file. The Export dialog box is displayed. 
8. Click OK. If you are sending by: 

• FTP the Send to ABE via FTP dialog box is displayed. Click Connect. A message 
is displayed saying that "Connection to ftp.abebooks.com successful". Click 
Send File. When the message "Transfer complete, closing connection" is 
displayed, click Exit. 

• Email the Sending via Email dialog box is displayed and the email is sent 
automatically. Click OK. 

For more information on sending via FTP or through email see the Notes below. 
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Options 

Books and Wants 

To send: 
• Only your books and wants that have been added or updated since the last time you 

sent, click Upload all changes since last load dates. This is the default. 
 
Books Only 

To send: 
• All books regardless of when they were changed, ensure the Upload Books and All 

Books radio buttons are selected, and that the Changes since last load date radio button 
is NOT selected. 

• Selected catalogs regardless of when they were changed, ensure the Upload Books and 
Selected Catalogs radio buttons are selected, and that the Changes since last load date 
radio button is NOT selected. 

• All books changed since last load date, ensure the Upload Books, All Books and 
Changes since last load date fields are selected. The date of your last upload is 
displayed. You can change the date and time if necessary. 

• Selected catalogs changed since last load date, ensure the Upload Books, Selected 
Catalogs and Changes since last load date fields are selected. The date of your last 
upload is displayed. You can change the date and/or time if necessary. Click Add to 
select the catalogs you wish to send. 

• A previously created file, ensure Send a previously created file is selected. 

Note:  

• You can remove all previous books on Abebooks by adding a purge request to any of 
the above options by selecting Purge in the Books section.  

Wants Only 

To send:  
• All wants regardless of when they were changed, ensure the Upload Wants radio button 

is selected and Changes since last load date is NOT selected and Changes since last 
load date is NOT selected. 

• All wants changed since last load date ensure the Upload Wants and Changes since last 
load date fields are selected. The date of your last upload is displayed. You can change 
the date if necessary. 

• A previously created file, ensure Send a previously created file is selected. 

Note:  

• You can remove all previous wants on Abebooks by adding a purge request to any of 
the above options by selecting Purge in the Wants section. 

Email vs. FTP 

You can send your data to Abebooks either by Email or FTP; however, we strongly recommend 
that you use FTP for the following reasons:  

• The size of the file is not restricted 
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• The file is sent directly to Abebooks. Email files must go through your Internet Service 
Provider first and can be rerouted after it has left your Internet Service Provider’s mail 
server.  

The default setting for sending files to Abebooks is by FTP. 

  
HOMEBASE 2 OPTIONS 

Options 

From the Options window, you can: 

Enter Bookstore information,  
Set confirmation windows  
Set Automatic Proper Casing  
Set Automatic Book#s  
Enter tax names and rates  
Add or Delete User IDs  
 
Entering Bookstore Information 

1. Click on the Options icon  on the toolbar 
2. Click the Bookstore Tab. 
3. Type your bookstore information. 
4. Click OK to save your changes. 

 

 

  

Email 
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If you do not plan to use Email to send files, you do not need to enter your outgoing mail server.  

Abebooks UserID and Abebooks Password 

To obtain an Abebooks UserID and Password, you require a bookseller account with Abebooks. 
A vendor account with Abebooks (the Advanced Book Exchange) enables you to exchange 
information with booksellers all over the world, and to search for books on Abebooks. 
For more information on the Advanced Book Exchange, or to become an Abebooks member type 
the URL: http://www.abebooks.com into your browser and you will be taken to the Abebooks 
homepage. 
  
Updating HomeBase 2 Properties 

1. Click on the Options icon  on the toolbar. The Options dialog box is displayed. 
2. Click the Editing Tab. 
3. Select the editing properties. If you select:  

• Confirm Adds a message is displayed each time you add or update information. 
Turn this off to bypass these confirmation messages. 

• Automatic Proper Casing then when you type information, the first letter of 
each word is capitalized even if you typed in a lower case letter. 

• Intelligent Author List the author field becomes an intelligent field. Please note 
that selecting this field may reduce the performance of HomeBase 2. See 
Intelligent Fields. 

• Intelligent Publisher List the publisher field becomes an intelligent field. Please 
note that selecting this field may reduce the performance of HomeBase 2. See 
Intelligent Fields. 

• Automatically Generate Book Ids then you do not have to type a book number 
each time you enter a book. HomeBase 2 does it automatically for you. Turning 
this option off allows you to enter your own book number for each new book and 
modify existing book numbers. 

• Tax name then you can add a tax by typing the name of the tax and the 
percentage. This tax information is displayed on your invoices. 

4. Click OK to save your changes. 
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Adding or Deleting HomeBase 2 UserID 

 

  

To Add a HomeBase 2 UserID: 

1. Click the Options icon on the toolbar. The options box is displayed. 
2. Click the Users tab at the top. 
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3. Click Add. 
4. Type the new user's name in the Name box near the bottom.  
5. Click Save. The new user is added to the list of users. 
6. Click OK. 

 
To Delete a HomeBase 2 UserID: 

1. Click the Options icon on the toolbar. The options box is displayed. 
2. Click the Users tab at the top. 
3. Select the User ID you wish to delete and click Delete. 
4. Click OK. 
 

WINDOWS HELP 

Scrolling in Windows 

To scroll down a list of items in a grid or list, use the scroll bar buttons on the right and bottom of 
the list. Clicking and holding on the arrows will move the data section. 
 
Selecting Multiple Items in a List 

While holding down the Control Key on your keyboard (CTRL), click on the empty gray button to 
the left of the row that you want to select. 

Repeat this for each row that you wish to select 

Note:  

• When you are selecting multiple items you must ensure that the background color for 
each item is blue. If one of the multiple items has a black background color the item is 
not selected. 

Wildcards 

Wildcards can be used in the FIND sections on list screens or in the REPORTS window.  
Wildcards are special characters that allow you to select a range of items based on variable 
elements in their spelling. 
The two wildcards that can be used are: 

• * (asterisk) means: any number of any characters 
• ? (question mark) means: any character (For example, type ‘b?ll’ to find either ‘bill’ or 

‘ball’ or ‘bull’) 
 
Examples 

You want to find all of the books with ‘john’ in the Author field from the Book list screen:  
• In the Author field in the Find Books section at the top of the screen, you could type: john 

This would result in a list of books where the Author field begins with ‘john’. 
• In the Author field in the Find Books section at the top of the screen, you could 

type: *john 
This would result in a list of books where ‘john’ appears anywhere within the Author field. 

 
You want a list of all books with the word ‘apple’ in the Title field from the Book list screen: 



HomeBase 2.1 User Guide 

44 

• In the Title field of the Find Book section at the top of the screen, you could type: *apple 
This would result in a list of all books with the word ‘apple’ anywhere in the Title. 

 

Shortcuts Using the Right Mouse Button 

As with many Windows applications, HomeBase 2 gives you a list of shortcut features using the 
right mouse button.  
 
To use right mouse button shortcuts: 

1. Place your cursor over the data on any of the Find screens and click the right mouse 
button. A shortcut list of actions is displayed. For example, if you are on the: 

• Find invoices screen and you right mouse click over the list of invoices you can 
list the total for the current list of invoices. 

• Find books screen and you right mouse click over the list of books you can mark 
selected books as sold or add selected books to a new invoice in addition to 
other options. 

Note:  

• You can also right mouse click on the fields of add or update screens to bring up a list 
of functions such as undo, cut, copy etc. 

Cut and Paste 

Cut and Paste in HomeBase 2 is implemented by the Windows standard keys: 

1. Select the text to be copied or moved. 
2. Press Ctrl + C to copy or Ctrl + X to cut. 
3. Click the areas where you want the information to go and press Ctrl + V to paste. 

Note: 

• If you prefer to use your mouse instead of using the keyboard to cut, copy or paste, select 
the text and then right click your mouse. A list of options is displayed. Select the action and 
click on it.
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